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What’s New 

This major release includes Touch Mode, a new way to interact with the existing product on touch-enabled 

Windows devices, for field application. This release also includes new features and improvements of the 

product. 

 

According to the maintenance expiration date policy, users under maintenance on March 12th, 2021 may 

access version 2021.1 with no new license required. 

 

Touch Mode > New field-friendly interface 

Generic 

Touch Mode is embedded in the product to help users in the field benefit from real-time inspection reports 

to get actionable information on the jobsite and reduce office work for their inspection task. 

 

The purpose of Touch Mode is to offer a selection of touch-friendly workflows to quickly create heatmaps 

and rich and leveraged reports via touch-based workflows. With the 2021.1 version, a BIM Inspection 

workflow will be available for users of the AEC Edition or Pro Edition. 

 

Touch Mode is an extension of the existing Cyclone 3DR product a new interface and a new way of 

interacting with the product to do certain tasks in the field. Access to Touch Mode workflows will be based 

on the user’s existing Cyclone 3DR license options. 

 

How to run Touch Mode? 

Touch Mode in Cyclone 3DR 2021.1 runs on Windows OS. See below for specific technical 

recommendations. 

 

The installation process creates two different desktop shortcuts for a quick access to the appropriate 

interface: 

▪ Cyclone 3DR, that launches current and “desktop” mode of the software 

▪ Cyclone 3DR Touch Mode, that runs the new Touch Mode interface 

 

From the menu of Touch Mode, it is easy to switch to the regular Desktop mode of Cyclone 3DR to proceed 

with any advanced feature and come back to the touch workflow in progress. 
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Homepage 

A new Homepage has been implemented to guide the users from the beginning of the Touch experience. 

The following screenshot introduces the different parts of the new Homepage. 

 
1. Main menu 

2. Start a new Touch workflow 

3. Open an existing Touch project: Windows browser opens the last opened folder from Homepage 

4. Portfolio of the recent user projects 

5. Help menu and About the product 
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Main menu 

The main menu is simple and has been designed for a field-friendly usage with the features: 

▪ Switch to Desktop, to run the regular mode if Cyclone 3DR advanced features are required for 

the job, in addition to the pre-defined features of the touch workflows 

▪ Settings, to access the simplified settings dialog of Touch Mode 

▪ Exit, to quit the application from the homepage 

▪ Go back to Homepage, to save the project and exit the workflow in progress 

  

Main menu from Homepage Main menu from workflow in progress 

 

Settings 

Basic settings are available in Touch Mode for a simple field usage. The Touch settings are composed of: 

▪ General preferences for basic user parameters 

▪ Language: Choose your language 

1 

2 3 

4 

5 



 

6 
 

▪ Display size: Large and Standard modes are available depending on the size of the screen 

▪ Unit: select Default Document Unit 

▪ Touch workflow settings for each enabled Touch Workflows, that includes BIM Inspection with 

the 2021.1 release 

▪ License for a quick access to manage Cyclone 3DR license, in addition to CLM software 

▪ Software Improvement Program, to easily let users manage their SIP preferences 

 

 
 

Touch Workflow screen 

Cyclone 3DR Touch workflow screen is detailed in the following image. It contains the main interfaces: 

 
1. Main menu 

2. Workflow ribbon, that allows to jump to the previous steps and some next steps 

3. Camera toolbar, to change the camera mode of the scene 

4. Visibility toolbar, to manage the visibility of the objects of the in-progress workflow 

5. Quick access menu, that provides Measure Distance and Create/Edit Auto-Limit box with the 
2021.1 release 

6. UCS selection, improved for the Touch experience with a quick selection feature 

7. Previous/Next bar 

8. Command dialog of the task in progress 

9. Reset Parameters / Help menu, which is a direct access the help of the opened command 

10. Specific tools, depending on the command needs 

11. Expand/Collapse the command dialog 
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Touch Camera and Navigation experience 

Many improvements have been done to support touch navigation of the scene in Cyclone 3DR. The 

behavior of the scene is very similar to other touch applications.  

 

Main touch gestures are: 

▪ Swipe with one finger: rotation or pan depending on camera mode 

▪ Swipe with two fingers: pan 

▪ Spread or pinch with two fingers: zoom in / zoom out 

▪ Brief tap on the scene: 

▪ Randomly in the scene: display/hide the quick access menu 

▪ On an object: action linked to the command in progress 

 

Available camera modes in Touch Mode are: 

▪ Orbit mode 

▪ Perspective mode 

▪ Top ortho: view from top view that disables rotation 

▪ Front ortho: vertical front view that enables rotation around Z-axis only 

▪ Fly mode 

▪ Panorama mode 
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Inside a workflow, the visibility of the objects can be easily managed from the toolbar. For the BIM 

Inspection, the following types are optionally visible: 

▪ Point Cloud 

▪ BIM Model 

▪ Inspected Model 

 
 

Zoom All function is also available in Touch Mode through a button from the visibility panel, which can be 

helpful during the Touch experience. 

 

 

Touch Limit Box 

Cyclone 3DR 2021.1 release embeds in Touch Mode the ability to create and edit one limit box. This 

feature is enabled from the quick access menu. Editing is possible thanks to the following features: 

 
1. Tool panel on the left 

▪ Toggle to de/activate the clipping 

▪ Reset a new auto-limit box from the current UCS 

▪ Select the axis to edit the box faces among X, Y, Z axis 

▪ Exit editing mode 

  
2. Slider on the right 

▪ Top grip to adjust the face of the maximum coordinate face along the selected axis – 

Numerical value to open the virtual keyboard and edit the coordinate of the face along the 

selected axis 

▪ Middle grip to translate the limit box along the axis - Numerical value to open the virtual 

keyboard and edit the thickness of the box along the selected axis 

▪ Bottom grip to adjust the face of the minimum coordinate face along the selected axis - 

Numerical value to open the virtual keyboard and edit the coordinate of the face along the 

selected axis 

 

The limit box is always hidden in the scene for a better touch experience, except when it is edited. 
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Touch Workflows 

The purpose of Touch Mode is to provide a panel of field-friendly workflows. With the release of Cyclone 

3DR 2021.1 version, BIM Inspection is the first released touch workflow, additional Touch Moe workflows 

will follow in future releases. 

 

To get started, click New from the Homepage to open the selection dialog of Touch Mode workflows: 

 
1. Workflow selector 

2. Preparation file, depending on the workflow, you may be required to select a 3DR project 
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Touch Mode > BIM Inspection Workflow 

General 

Cyclone 3DR 2021.1 offers a BIM Inspection workflow within Touch Mode. The goal of the field job is to 

load a BIM model into 3DR, to import a scan from Cyclone FIELDWORX or from a local file and to launch 

a live inspection in order to immediately deliver a report, leveraged with detailed notes. 

 

Licensing: The BIM inspection workflow is available to users with the AEC and PRO licenses. 

 

Settings: Simple Touch Mode settings menu provides the global preferences for each Touch workflow. 

With the new release, global preferences are: 

▪ Maximum Imported Points: limits the number of points when importing and converting a point 

cloud in the workflow. 

▪ Best Fit Tolerance (Mean Value): the tolerance for best-fit computation in the Check Alignment 

command. 
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Preparation file: a prepared 3DR project (from Desktop Mode) is necessary to launch the workflow. Its 

contents must be: 

▪ At least a loaded BIM project from IFC or RVT files. Minimum recommendations are at least: 

▪ One BIM model of the project to check, align, clean the data: this BIM Model does not 

necessarily include all the initial full Project but should be representative enough to facilitate 

the alignment with the captured data 

▪ One BIM model of each group of the construction elements that are concerned by the field-

inspection 

▪ Personal UCS set from Cyclone 3DR Desktop Mode: optional but useful for the workflow 

It is possible to have other kinds of 3DR objects in the preparation file. They won’t prevent the BIM 

Inspection workflow from running but they won’t be used or displayed in the BIM Inspection workflow. 

 

 

Details of the workflow 

The workflow is split in 4 main steps: Load, Prepare, Inspect and Deliver. 

 

At any point in the workflow, it is possible to switch to the Desktop Mode to use other advanced tools. 

 

Load: The purpose of Load is to select the BIM Model and the point cloud that would be necessary to 

launch and compute the workflow. 
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▪ BIM Model: This command displays the list of the BIM Models that are part of the 3DR preparation 

file. This first selection will be used to align and clean the point cloud in the following steps. One 

selection is mandatory in the list. 

 

 

 
 

▪ Scan: The goal of the next step is to import the Scan cloud that will be compared to the BIM Model. 

Two options are released: 

 
1. Connect to Cyclone FIELDWORX: clicking on this option browses a user-friendly dialog to select 

the databases which have been registered through Cyclone FIELDWORX on the same tablet 
device. 

2. Open a local file: a windows browser is displayed to allow the user to select a local file. LGS, E57 
and PTS are supported in this workflow. 
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Connect to Cyclone FIELDWORX is easy to use: 

 
1. The list of the projects is displayed on the left 

2. All the project Model Spaces are displayed in a portfolio for an easy finger-selection and import 

3. Users can sort the Model Spaces to quickly locate the one to be used 

4. Import the Model Space in Cyclone 3DR 

1 2 
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Prepare: The purpose of Prepare is to check the captured data and to prepare it in relation to the selected 

BIM Model by aligning and cleaning it. 

 

▪ Align: This new feature is very similar to Visual Alignment workflows in Cyclone REGISTER 360 

and Cyclone FIELD 360. The goal is to use the alignment controls to rotate or to translate the 

selected object (point cloud or BIM Model) in order to manually align the two inputs together. 

The features of Align can be sorted in different groups: 

Preparation: 

1. Pre-Align: to translate the moved object from its centroid to the other input centroid. This 
feature is proposed at the beginning of the step Align when the scan and the BIM Model are 
too far from each other. It provides time saving and simplicity at the beginning of the process. 
It should be used before processing manual alignment. The user has the choice of moving 
either the Scan or the BIM Model depending on the known geo-referenced object. 

 
 

Instructions: 

2. Instructions: to guide the users in the command 
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Options: 

3. Moved object: to define which input object is being moved. Ability to switch the input at any 
time in the command. 

4. Preserve horizontality: by default, this option is checked because we can expect that the two 
inputs are properly aligned to the vertical direction in most of the cases. Unchecking this option 
enables rotation in the front-ortho camera view to edit the orientation of the moved object 
around horizontal axis. 

3D Scene Interaction: 

5. Manipulator: to manually translate or rotate the moved object in the 3D scene, depending on 
the selected camera mode. 

6. Position: the manipulator is automatically positioned at the coordinates of the centroid of the 
moved object. In many situations, it is useful to change the position of the manipulator and 
clicking on this command enables the user to define a new position. 

7.  Camera toolbar: in Check Alignment, the following cameras are enabled 

▪ Top-ortho camera view: default mode of the command 

▪ Front-ortho camera view: rotation around Z-axis is enabled 

▪ Orbit camera: in this camera mode, the alignment control is disabled, and the purpose is 

to provide a visual checking 

 

Automatic commands: 

8. Best-Fit: to launch a best-fit. Some advanced parameters can be adjusted in the settings. 

9. Notifier: to summarize the results of the Best Fit calculation and to confirm if the operation is 
under the user-defined tolerance threshold (Touch Mode settings). 

 

This step of the workflow is optional. Using a geo-referenced BIM Model and a 

geo-referenced scan data makes this step unnecessary. 
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Below is a suggested set of tips to easily align and accurately best-fit the two objects: 
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▪ Select the appropriate objected input. We recommend selecting the object which is not 

georeferenced to align it to the one which is georeferenced. the purpose is to maintain the 

one that has already a georeferenced position. 

▪ Un/Check the Preserve Z-Axis orientation if necessary. The rotation control will be 

disabled in the front-ortho camera view. 

▪ Use Pre-Align when the two objects are very far from each other 

▪ Interaction in the 3D Scene: 

▪ Adapt the position of the alignment control on a specific angle that is easy to recognize 

on both inputs, then use the alignment control to translate and to rotate the selected 

input. 

▪ Repeat the process in top-ortho camera view and in front-ortho camera view. 

▪ Activating and resizing the limit box may be useful in some situations 

▪ Collapsing the dialog will offer a larger scene to use the alignment control 

▪ Finally launch a best-fit. 

 

 

▪ Clean: This command provides two easy features to clean the data, in addition to the existing 

panel of cleaning features that can be found via the Desktop Mode. The two methods Clean 

according to Distance and Clean unclipped points must be toggled on to compute the cleaning. 

Both options can be activated at the same time. 

Cleaning is an optional step. Depending on the situations (noisy clouds, unexpected captured 

objects such as works equipment, people, furniture) and for a better user experience with the 3D 

scene, it may be useful to remove some parts of the point cloud and to proceed a cleaning after 

having properly aligned the BIM Model with the point cloud. 
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Cleaning methods: both methods are compatible and can used at the same time to remove unkept 

points from the project 

1. Distance: toggle to keep only the points that are close enough to the BIM Model (See Distance 
Threshold) 

2. Limit Box: toggle to keep only the visible points 

Options: 

3. Distance threshold: user parameter for the Distance method 

Compute: 

4. Compute: launch the cleaning before moving on to the Inspection step 
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Inspect: This step of the workflow is composed of the 3 tasks BIM Model, Parameters, Colormap 

▪ BIM Model: The list of the BIM Models is displayed in the command dialog in order to select the 

part of the BIM Project that is inspected in the next steps of the workflow. 
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▪ Parameters: This command is necessary to define the user parameters of the inspection between 

the BIM Model and the point cloud. The options of the feature are: 

 
1. Force Projection: Selection of 3D deviation or 2D deviation along the main axis X-Y-Z 

2. Options: Maximum searching distance between the BIM Model and the point cloud 

3. Compute / Reset: One button to launch or reset the inspection computation 
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▪ Colormap: the final step of the Inspection step of the workflow is dedicated to editing the gradient. 

The two main parts of the command dialog are: 

 
1. Predefined gradients: Three predefined gradients are available for a touch-friendly 

experience: Tolerance, Over/Under and Regular steps. A user can also switch to Desktop 
Mode if they require more advanced gradient options and then return to Touch Mode. 

2. Options of the selected gradient: For each gradient option, different controls are available 
for users to customize their output. 

 

 
 

 

Deliver: The final step of the workflow is focused on reporting. New for 2021.1, delivering throughout the 

product has been improved with a streamlined UI, ability to edit notes and the addition of quick reports. 

These new features greatly benefit the BIM Inspection workflow.  

 

▪ Add Notes: This new feature enables users to create notes from the BIM inspection. Users can 

create the notes they need to make the report richer. 

The workflow is simple: 

▪ One click on the main scene button to launch note creation and edition. 

▪ One single tap on any BIM object to create a new note. 

▪ One single tap on a note to enable edit/delete buttons. 

▪ The list of the notes is displayed in the command dialog, where editing and deleting are also 

enabled. 
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Features of the command are: 

 
1. Create a note: click to activate the note creation mode – then tap on the inspected BIM Model 

to create a new note. 

2. Note marker: a new style has been introduced to flag the created notes 

3. List of notes: the created notes are listed in the dialog command and the contents are 
summarized. A warning icon is displayed when no information are linked to a note. 

4. Edit/Delete selected note 
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A new toolbar is enabled when editing a note. The available options are: 

 
1. Create/Edit information from the scene: Ability to create deviation labels and screenshots of the 

3D scene. 

2. Take/Edit camera pictures: This command enables the camera from the tablet to take pictures. 

3. Create/Edit user comments: New name for the note and user comments are included in the final 
PDF deliverable 

4. Quit the edition 
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The gallery commands for the captured images or of the camera pictures opens a new dialog with the 

options: 

 
1. Go to previous image 

2. Go to next image 

3. Update/delete 

4. Done 
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▪ Final Report: A simplified interface has been implemented for field-friendly usage.  

 
1. User text parameters of the report: report title, author, company name and customer name 

2. User image parameters of the report: company and customer logos 

3. Update: to reset the report after the user parameters have changed 

4. Export: to create a PDF report and a CSV file from deviation labels 

5. Preview of the PDF report 
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File > Import IFC and RVT: New management of BIM Model 

The management of BIM Projects has been improved with the 2021.1 release. BIM Model or BIM Object 

is now a new kind of object and is distinguished from other CAD objects. It is now possible to manage 

multiple BIM Models in Cyclone 3DR from one unique import of a BIM Project and every BIM Model can 

display and refer to a specific part of the initial BIM Project. 

 

This new feature is enabled for IFC-format and RVT-format models that are imported. 

 

This new feature will be useful for every application in the construction industry when projects are 

developed through BIM process. 

 

The behavior of BIM Models has been updated with the following changes: 

 

▪ Composition of BIM Models in 3DR: BIM Models in 3DR files not only load the geometry but 

now retain all the additional attributes stored in the IFC or RVT file including the IFC type of each 

geometry. 

 

▪ Editing: After import, the visible and activated contents of the BIM Project can be edited, which 

means that elements from the same BIM Project can be loaded or unloaded directly into the 

created object BIM Model imported in Cyclone 3DR. 

▪ For example, the user can start the workflow with importing a BIM Project and creating a BIM 

Model in Cyclone 3DR that contains the first level of the BIM Project only. Later and without 

importing again, the user can decide to update the same BIM Model in 3DR, by loading the 

second level as well via a quick editing of the imported model; or he can decide to create 

another BIM Model in 3DR that displays the second level only. Importing the full BIM Project 

again is not required. 

▪ RIGHT click or double LEFT click in the tree view or on the object in the 3D scene to access 

BIM Model editing in Cyclone 3DR. 
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There are significant improvements to the BIM editing tools with the improved support for IFC 

and Revit formats.  

▪ Improved hierarchy in the dialog box to display the structure of the project, considering the 

type of the elements 
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▪ Improved filter feature to read the names and properties of the elements 

▪ Selected elements of the BIM Model are outlined in the scene by their bounding boxes. 

 

 

▪ Multi selection in the scene is now possible, including the standard keyboard shortcut for 

selection such as CTRL or SHIFT for a window-selection 
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▪ For each selection of element(s) of the BIM Model, ability to LOAD / LOAD ONLY / 

UNLOAD the selection 

   

 
 

▪ Management of multiple BIM models: From the original BIM Project, any BIM Model or BIM 

object can be copied, added, edited or removed. This means that after the first import of the BIM 

Project, it is possible to create another BIM Model in the same 3DR project, having a direct link to 

the external file. 

▪ For example, after having loaded a BIM Model in Cyclone 3DR, a user can now create specific 

BIM models for each parts of interest of the building (the slabs, the pipes, the columns, the 

facades, the levels and so on). the BIM Model in 3DR is as flexible as the original model built 

in the BIM software. This new feature is very useful when it is necessary to conduct different 

workflows for different parts of the building. 

▪ To proceed, the workflow is easy: 

▪ Select the BIM Model 

▪ Copy/Paste the selection 

▪ Rename and edit the pasted BIM Model 

 

 
 

The image shows a new icon and a new BIM group to easily identify BIM Models. The BIM Models from 

this example were created from the only «Hexagon House » BIM Project. 
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▪ Inspection: 

▪ Inspection commands have been upgraded to support and to distinguish BIM Models from 

regular CAD Models: 

 

  
 

▪ BIM Models support inspection information: This new feature is useful for the Touch BIM 

Inspection workflow to create linked notes for report. By embedding the deviation information 

in the BIM Model directly, BIM interoperability is improved because the reference ID of the 

inspected BIM element is automatically linked to the created note in the report. 

 

 

▪ Rendering: The rendering of BIM Models has been improved in order to distinguish those 

elements from regular CAD objects and to target the best BIM-experience possible. 
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▪ Main representation = BIM: The color information of a BIM Object is read and is used for the 

rendering in Cyclone 3DR. The “rainbow” icon stands for the BIM representation. 

Transparency of specific objects such as windows is also supported with the new release. 

 

 
 

▪ Secondary representation = FLAT: It is possible to user-define another color for the full BIM 

Model. The unicolor icon stands for the FLAT representation. 

 

 
  



 

32 
 

▪ Orientation of the surfaces: the new management of BIM Models allows now to check if the 

surfaces are properly orientated depending how the BIM Model has been created in a third-

party software. 

 

 
 

▪ Extracting mesh: A new feature is available to extract a mesh from a BIM Model in the Extract 

Mesh tools. 

 

  
 

This new feature is embedded in the new Touch BIM Inspection workflow and the benefits are: 
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▪ Easy preparation: Save time and flexibility when creating a preparation 3DR file from one BIM 

Project. Define the appropriate BIM Models to proceed the workflow in-the-field and focus on the 

areas of interest. 

▪ Improved rendering: the upgraded rendering fits the BIM standards 

▪ Leveraged report: each reported note is linked to one unique BIM element thanks to its BIM 

identification number  

 

 

This feature is available to users with the AEC and PRO licenses. 

 

File > Import LGS format 

With the 2021.1 release, it is possible to directly import a LGS file and to shortcut the CloudWorx plugin 
for Cyclone 3DR. 

 

In order to import a LGS file, it’s possible to drag and drop the file into 3DR application or to open File 

menu and choose import. When importing LGS file, the default mode is import but a new option is proposed 

to convert directly the LGS point cloud, including the existing options (maximum number of points, convert 

images and/or point cloud). 

 

 
 

The existing Open LGS feature remains available in the CloudWorx menu. 

 

This feature is available to users with the Standard license. 
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Generic > New camera and navigation experience 

For better consistency between Cyclone Products and an easier experience, camera and navigation 

modes are updated with the new release of Cyclone 3DR 2021.1. 

 

The main change is the point that “selection mode” (previous “mouse cursor” icon) has been removed. 

Now selection is automatically available in standard Cyclone cameras, which means: 

 

▪ In any kind of views: 

▪ A single click on an object is required to make a single selection 

▪ Keep pressing LEFT SHIFT to make a window selection 

▪ Pressing LEFT mouse click manages the main camera tool depending on the camera mode 

(for example: rotation in ORBIT Ortho or ORBIT Perspective) 

▪ In ORBIT PERSPECTIVE mode: 

▪ Maintaining RIGHT mouse click enables panning in the 3D Scene 

▪ Maintaining LEFT+RIGHT mouse clicks at the same time enables PANORAMA view 

 

 
 

▪ In specific commands when a selection with LEFT mouse click is expected, the users must press 

LEFT CTRL to rotate the scene. Commands are:  

▪ CLEAN/SEPARATE (Clean and Surface Modeling) 

▪ ADJUST TEXTURE (Texturing) 

▪ LIMIT BOX EDITION (View) 

▪ SMOOTH WITH A BRUSH (Surface Modeling) 

 

For such commands, another method is proposed to the users to avoid the usage of the LEFT 

CTRL shortcut in order to pause the selection mode: 
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On the image above, selection mode has been removed. 

 

This feature is available to users with the Standard license. 

 

Generic > Tool tips for ribbon commands 

Cyclone 3DR 2021.1 provides new tool tips for the commands that are in the ribbon. These generic tool 

tips are implemented for all the buttons in the menus and it displays: 

 

▪ The complete name of the feature. 

▪ The required license to launch the command: Standard, AEC, Survey, Tank. 

▪ The direct shortcut to the Help menu chapter. 

 

 

  
 

▪ Optionally, additional details about the command. 

 

 
 

This feature is available to users with the Standard license. 
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Generic > Auto-update 

Cyclone 3DR 2021.1 embeds an automatic feature to check if any product updates are available when it’s 

online. 

 

By clicking on the new “Check for updates” icon on the top-right of the software window, a pop-up window 

is displayed with the following information: 

▪ The version of Cyclone 3DR that is currently installed. 

▪ The updated online version of Cyclone 3DR. 

▪ The release notes summary including updates from the current version of 3DR. 

▪ A quick access to the published release notes. 

▪ A quick access to Cyclone 3DR webpage. 

▪ A quick access to download the installer directly from the application: while downloading, the users 

can keep on doing their in-progress tasks in Cyclone 3DR. 

 

 
 

▪ At the end of the download, a quick access to launch the installation is provided from the same 

pop-up window. It is recommended to save the work in progress before launching the installation 

because the process will temporarily close the application. 

 

 



 

37 
 

  
 

Download in progress     Ready for installation 

 

A colored dot is automatically added when the current version is not the updated and last one: 

▪ Red dot to indicates that the new version is enabled and can be downloaded. 

▪ Orange dot indicates that download is in progress. 

▪ Green dot indicates that the new installer is downloaded and ready launch. 

 

 

       
 

The new feature can detect if the current version is the latest version and if the maintenance policy of the 

user allows him to benefit from the new version.  

 

This feature is available to users with the Standard license. 

 

Clean > Detect Moving objects 

Cyclone 3DR 2021.1 benefits from a new algorithm to clean point clouds: points representing moving 

objects are automatically detected and can be removed or isolated. This new feature completes the panel 

of cleaning solutions in Cyclone 3DR and offers a new user-friendly and time-saving feature to clean a 

point cloud before starting a workflow. Users of Cyclone REGISTER 360 will be familiar with this cleaning 

option. 

 

The new command works on data collected with Terrestrial Laser Scanners which contain several scan 

positions. The process considers the differences between scan positions in order to determine what objects 

have moved between setups and are not static features of the scene. 
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To clean moving objects: 

1. Select the point cloud 

2. Run Detect Moving objects from Analysis menu 

3. Define the parameters to adjust the accuracy of the computation (image below) 

4. Launch Preview / OK 

5. After a Preview, the users can select if the detected points are kept in the 3DR project. 

6. Rate (%) of detected points is displayed. 

 

 
Red points stand for the moving objects: people and moving vehicles are detected in the image above. 

 

 

This new feature is useful for any application that use TLS scanners. 

 

This feature is available to users with the Standard license. 

 

Analysis > Edit Colors > Distribution Information  

Cyclone 3DR 2021.1 provides a new option in the Edit Colors command to manage the distribution chart 
from any kind of inspection job or inspected objects which support a gradient. It is now possible to add or 
remove the distribution information. Sometimes distribution is inappropriate and can be hidden for a 
better rendering of the results in the scene or in the report. 

 

A new checkbox is part of the Edit Colors dialog command. 
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Distribution information is on. Distribution information is off. 

 

This feature is available to users with the Standard license. 
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Analysis > Measure geometry 

Cyclone 3DR 2021.1 includes a new command to measure geometric features (dimensions and position) 

and to compare them to nominal values. This command is enabled for Lines, Rectangles, Cylinders, 

Circles, Planes, Spheres and Cones. 

 

This new feature from the Analysis menu creates a label for each selected geometrical object and outlines 

the comparison to the nominal values, that are defined by the user. 

 

 
 

To measure geometry: 

 
1. Select multiple geometrical objects of the same and unique type (ie all windows of the same 

dimensions) 

2. Launch Measure Geometry from Analysis menu 

3. Define the nominal values or Select a Reference geometry (optional) 

4. Adjust the expected contents of the created labels 

▪ Coordinates 

▪ Dimensions 

▪ 2D or 3D deviations 

5. OK Next to start again the workflow or OK Exit 
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Such geometry measurements can be necessary when an inspection of multiple geometric features is 

needed by the users. In the construction industry for example, the users can measure and report a group 

of similar construction elements. Or for manufacturing applications, the dimensions of geometric features 

can be automatically compared to common and nominal values. 

 

 

3 

4 

5 
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Example of windows of a facade compared to a nominal and standard windows dimensions 

1 Theoretical window in green – 7 Measured windows in red  

 

Main benefits of this feature are time saving and automatic creation of labels from a multiple selection as 

a batch process. The label values are automatically defined as report data and can displayed in the final 

report. 

 

This feature is available to users with the Standard license. 

 

Extract > New algorithm for plane extraction 

The performance of the automatic plane extraction algorithm has been significantly upgraded with a new 

algorithm. This update does not bring many UI changes in the existing application, but this powerful 

algorithm decreases the time of calculation for all the functions that are linked to plane extraction: 

 

▪ Extract > Region Grow geometrical features (rectangles, circles, planes) 

▪ Extract > Planar Contour 

▪ Get Normal from surfaces 

 

The existing command Extract > Planar contour, which benefits from this new algorithm, introduces some 

changes: 

 

▪ New experience in the command: 

▪ First click on one or several points to validate the “region grow” plane 

▪ Then preview the contours 

▪ New option to skip points whose normal differs from the plane normal to get rid of inappropriate 

areas 
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User Experience has also been improved with the new ability to define the tolerance extraction of the plane 

before running the region grow calculation. 

 

 

This feature is available to users with the Standard license. 
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Surface Modeling > Local Smoothing 

With the 2021.1 release of Cyclone 3DR, Local Smoothing has been migrated from 3DReshaper. This 

feature completes the panel of Mesh Improvement tools in the Surface Modeling menu and provides a 

user-friendly way to clean the surface mesh in 3DR. 

 

The workflow to launch Local Smoothing in 3DR is: 

▪ Select the input mesh to clean. 

▪ Launch Local Smoothing from Surface Modeling menu. 

 

 

▪ Define the two options that are very simple to use: 

▪ The brush size depending the areas that need to be smoothed. 

▪ The smooth intensity on the expected results. 
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▪ Directly interact with the 3D scene to proceed then local smoothing: 

▪ Keep the mouse LEFT click to smooth locally. 

▪ Unzoom or zoom on the concerned area to adjust the number of mesh triangles to smooth. 

▪ Keep pushing Left CTRL key to activate rotation mode instead of brushing. 

 

  
Original mesh input Mesh output after a local smoothing of the 

ground. 

 

▪ Validate the workflow by clicking OK. 

 

This tool is relevant to clean detailed mesh that were built from a point cloud with lots of noise, which 

means many kinds of applications. Heritage and architecture are appropriate situations where Local 

Smoothing is useful. 

 

This feature is available to users with the Standard license. 

 

 

Script > Getting Started > Frequent Questions 

With the 2021.1 release, the documentation is updated with a new chapter Frequent Questions in the 

Getting Started chapter. 

 

To access the document of scripting features, it’s necessary to: 

▪ Go into the script menu 

▪ Run a script 

▪ Click on the documentation icon 
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The Frequent Questions chapter can help beginners in scripting to learn basic tasks in scripting. 

 

 
 

It also refers to the free online GitHub of Cyclone 3DR scripts that provides now a new script called 

“MyFirstScript” (https://github.com/Cyclone3DR/Scripts/tree/master/MyFirstScript) that beginners can 

benefit from in order to learn scripting functions to achieve common tasks in Cyclone 3DR: 

▪ Open an existing 3DR project 

▪ Select of an object in the scene as input of the script 

▪ Create of a basic mesh from a point cloud 

▪ Create of a pop-up dialog to require user parameters 

▪ Change object parameters (name, color, transparency) 

▪ Extract planar sections along the vertical axis 

▪ Inspect/Compare a point cloud vs. a mesh 

▪ Extract the best plane of an object 

▪ Create a label 

▪ Export a textured mesh in OBJ format to a user-defined folder 

 

 

This feature is available to users with the Standard license. 

 

 

  



 

47 
 

Improvements 

In 2021.1.0 release: 

 
▪ Generic > Support of HDPI Display (4k): Added support for Windows display scaling on high 

resolution screens. 

▪ Home > Settings > Geometrical features: Display options (axis, center) of geometrical 
features (circles, cylinders, …) can be directly managed via the object explorer instead of the 
global settings. 

▪ Home > Settings > Polylines: Arrows standing for polyline orientation can now be edited via 
the object explorer, instead of the global settings. 

▪ File > Import DXF/DWG: An option has been added to force a specific import unit when the 
imported file does not have a unit parameter. 

▪ File > Import DXF/DWG: Colors are properly imported in the application. 

▪ File > Export E57 format: The size of exported files is significantly reduced without reducing 
the quality of the data. 

▪ File > Import meshes: Random colors are used when several meshes are imported at the 
same time in a 3DR Project. 

▪ File > Send to Autodesk Autocad: Compatible with Autocad 2022. 

▪ File > FARO Library: Update to support FARO LS 1.1.800.6 

▪ Analysis > Measure > Cut and Fill: Report contents from Cut and Fill analysis is improved 
with the full results that are displayed in the command dialog. 

▪ Coord Sys > UCS: New interactive tool to define a new UCS or to select existing UCS directly 
in the scene 

        

 

▪ Coord Sys > Free Move: Free move movements have been accelerated for CAD models, 
Meshes and Point Cloud 

▪ Clean > Stretch Polyline: Add an option to project the input polyline on a plane in addition to 
meshes 

▪ Extract > Cloud > Grid Projection: Add an option to fit the extracted points on the grid. 

▪ Extract > Scan to Plan: In the Extract task of the workflow, the directions of polylines are 
always displayed, and a new feature has been added to reverse the polylines directly in the 
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command. “Send to Floorplanner” benefits from this improvement. 

▪ Scene Interaction > Inspection values: Quotation texts from deviation values are now 
automatically displayed face to the screen normal for a dynamic and better presentation of the 
results. 

▪ Script: Add methods in SSetMultilines class to compute the external contour. 

▪ Surface Modeling > Fill Holes: Add an option to prevent self-intersecting surfaces on 
complex holes from being generated. 

▪ Surface Modeling > Subdivide: The feature has been upgraded to improve meshes in 
curvature areas. 

▪ View > Limit box: When editing a limit box, a new SPACE shortcut replaces now the previous 
shortcuts for a smoother experience. A single click on SPACE enables a new mode among 
the different translation modes: one face, two opposite faces, the whole limit box. 

 

Bug Fixes 

 

In 2021.1.0 release: 

 

▪ Analysis > Inspect Section vs. Section: Fixed a bug that generated wrong results when two sets 

of sections were compared when the two sets had a different number of sections. Each section is 

now compared with the closest one from the other set. 

▪ Clean > Clean Separate: Fixed a crash that could appear when command started just after 

showing or creating a cloud. 

▪ Clean > Smooth Polyline: Fixed a crash that could appear when multiple polylines were projected 

on an object. 

▪ Extract > Grid Projection: Fixed an extraction failure when the area around the grid point was 

flat. 

▪ Report Editor: Fixed a crash that happened when moving table headers. 

▪ Scene Interaction > Window Selection: Fixed a bug that happened for a window selection of a 

cloud with clipped points. 

▪ Surface Modeling > Cut Mesh: Fixed a crash that occurred when multiple polylines were present 

with the option “Project polylines” checked. 

▪ Texturing > Extract ortho-image: The extracted image could be offset from the original frame. 

▪ Texturing > Texture from Images: Fixed an issue that considered a wrong priority order when 

applying new texture on an existing textured mesh. 

 

Generic specifications 

Leica Cyclone 3DR 2021.1 Compatibility 

▪ Cyclone 3DR is compatible with CLM 1.8 and higher.  

▪ Cyclone 3DR is compatible with JetStream Enterprise 1.3 and higher.  

▪ Cyclone 3DR is compatible with LGS files. 

▪ Cyclone 3DR is compatible with Cyclone IMP databases from Cyclone 6.0 or higher, however 

improved rendering will only be seen with IMPs from Cyclone 9.3 or higher. 

 

Known issue: Cyclone 3DR 2021.1.0 does not provide a direct connection to Cyclone Enterprise. This 

feature is expected  
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Recommended Computer Specifications 

 

Regular workflows: 

▪ CPU: 2 GHz Dual Quad Core i7 or higher (i5 minimum) 

▪ RAM: minimum 16 GB or more for 64-bit OS 

▪ Graphic Card: NVidia Quadro or GeForce 1 GB (with OpenGL support, versions 4.3 or higher) 

▪ Operating system: Microsoft Windows 7, 8, 10 (64 bits supported) 

▪ Hard Disk: 3 GB free disk space 

 

 

Tablet device for Touch Mode: 

▪ Microsoft Surface PRO Core i7 1.5 GHz – 16GB RAM. 

 

 

Installation and Licensing Recommendations 

Installation update Procedure  

 

1. Follow the directions in the Setup Wizard  

 

  
 

2. Select the option to update Cyclone 3DR (or repair if you want to change installing options) 
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3. Complete the installation by selecting “Finish”. 

 

Licensing Setup  

1. Once you have installed Cyclone 3DR, open the Client License Manager for Floating Licenses. 

The program is located here: Start Menu | All Programs | Leica Geosystems | Client License 

Manager 

 

 

*NOTE* Be sure to choose the CLM Floating option (there are two CLM options 

and the Nodelocked CLM will not activate your license)  

2. Choose the "Activate new licenses" option.  
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3. Enter your Entitlement ID (EID) in the field. To enter multiple EIDs separate them with a semicolon 

";" and no space. 

 

 
 

4. After you have entered your EID, choose the "Check for Activatable licenses" button in the bottom 

right of the page 

 

 
 

5. Once your licenses are activated you can launch Cyclone 3DR.  

6. Go to Settings and select License. 
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7. If you have entered the EID inside your local CLM, select Localhost. If the license is on a 
dedicated server, enter the server name in Server Address. 

 
 

 
8. You can select the features you want to check out from CLM. The available options to checkout 
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will correspond to the options you purchased which are contained in your EID. 

 

 
 

9. Once the options are selected, click on Activate license. 
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Licensing 

All users with valid CCP or CCP which was valid as of 12 March 2021 for Cyclone 3DR, can run this new 

version of Cyclone 3DR. 

 

All users with valid CCP or CCP which was valid as of 12 March 2021 for 3DReshaper, can run this new 

version of Cyclone 3DR with no new license required. 

 

Users with 3DReshaper licenses with expired CCP must migrate to Cyclone 3DR in order to continue to 

access updates and support. Please contact your sales or support personnel for more information.  

 

 Known Issues 

 

▪ The Documentation Center is only available in English. 

▪ Some CAD import and export issues might happen. For example, when exporting a cloud in DXF, 

some entities might be missing. To avoid this, it is preferable to use the Send to AutoCAD option. 

▪ If DXF can be imported with a standard version, DWG requires the AEC or PRO Edition. One 

workaround is to use the 3DSend command from AutoCAD to Cyclone 3DR. 

▪ .RSH files are natively compatible with Cyclone 3DR, and the last version of 3DReshaper is 

compatible with .3DR files (with a limit on textures and CAD objects). 

 

Leica Cyclone 3DR supported file formats 

Please reference the Cyclone 3DR Technical Specification for a complete list of supported file types per 

license.  

 

 Import Export 

Point 

Cloud 

Files ASCII (*.asc, *.csv, *.xyz, *.yxz…) 

Leica Geosystems (*.pts, *.ptx) and LGS 

(*.lgs) 

Leica Nova MS50/60 (*.sdb, *.xml) 

ShapeGrabber (*.3pi) 

3DReshaper binary file (*.nsd) 

AutoDesk DXF (*.dxf) 

STL (*.stl) 

Polyworks (*.psl) 

Leica T-Scan + Steinbichler (*.ac) 

LIDAR data (*.las; laz) 

Other ASCII (*.*) 

Zoller and Fröhlich *(.zfs - *.zfc) 

PLY points without triangles (*.ply) 

ESRI ASCII (raster format *.asc) 

FARO (*.fls - *.fws) 

ASCII FILES (*.asc, *.csv…) 

Binary files (*.nsd) 

Leica Geosystems (*.pts, *.ptx) 

E57 (*.e57) 

IGES (*.igs) 

LAS (*.las) 

LAZ (*.laz) 

Autodesk DXF (*.dxf) 
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POLYWORKS (*.psl) 

E57 (*.E57 files) 

LandXML files (*.xml) 

DOT Products (*.dpl) 

RDBX 

Mesh STL format (*.stl) 

Binary PBI format (*.pbi) 

DXF 3Dface format (*.dxf) 

Ascii POLY format (*.poly) 

OBJ format (*.obj) 

Ascii Leica format (*.msh) 

VRML files (*.wrl / *.vrml / *.iv) 

OFF files (*.off) 

PLY (*.ply) 

Ascii and binary STL format (*.stl) 

Binary PBI format (*.pbi) 

DXF 3Dface format (*.dxf) 

Ascii POLY format (*.poly) 

Vertices only (*.asc) 

DXF polyline (*.dxf) 

IV Format (*.IV)Ascii Leica format (*.msh) 

VRML 2 (*.wrl / *.vml / *.iv) 

PLY (*.ply) 

LandXML (*.xml) 

OBJ format (*.obj) 

Contour / 

Section 

IGES format 

DXF polyline format 

Binary MLI format (*.mli) 

 

IGES format 

DXF polyline format 

Binary MLI format (*.mli) 

ASCII formats 

CAD Model IGES 

STEP 

DWG 

IFC 

RVT 

IGES 

STEP 

DXF 

Project Cyclone 3DR (*.3dr) 

DXF - DWG 

XML 

Cyclone ModelSpace View (from IMP) 

JetStream Enterprise project  

Cyclone 3DR (*.3dr) 

DXF 

PDF 3D 

SKETCHFAB 

Image BMP 

JPEG 

JPG 

PNG 

Ortho-image including georeferencing 

information as TXT file 

JPG 

JPEG 

BMP 

PNG 

TIF 

GIF 
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Cyclone 3DR provides “SendTo” features as well to import and export certain kind of data with third-party 

products. More information is available in Cyclone 3DR documentation center (from the software help 

menu). 

 

 

 Send From Send To 

Point Cloud - - 

Mesh / 

Surfaces 

AUTODESK AutoCAD 

HEXAGON MineSight 3D 

AUTODESK AutoCAD 

HEXAGON MineSight 3D 

Contour / 

Section / 

Points 

AUTODESK AutoCAD 

HEXAGON MineSight 3D 

AUTODESK AutoCAD 

HEXAGON MineSight 3D 

CAD Model AUTODESK AutoCAD - 

Image - AUTODESK AutoCAD (ortho-image) 

 

 


